This page is deliberately left empty.
Proprietary Notice and Liability Disclaimer

The information disclosed in this document, including all designs and related materials, is the valuable property of NEC Computers S.A.S. and/or its licensors. NEC Computers S.A.S. and/or its licensors, as appropriate, reserve all patent, copyright and other proprietary rights to this document, including all design, manufacturing, reproduction, use, and sales rights thereto, except to the extent said rights are expressly granted to others.

The NEC Computers product(s) discussed in this document are warranted in accordance with the terms of the Warranty Statement accompanying each product. However, actual performance of each product is dependent upon factors such as system configuration, customer data, and operator control. Since implementation by customers of each product may vary, the suitability of specific product configurations and applications must be determined by the customer and is not warranted by NEC Computers S.A.S.

To allow for design and specification improvements, the information in this document is subject to change at any time, without notice. Reproduction of this document or portions thereof without prior written approval of NEC Computers S.A.S. is prohibited.

Trademarks

Adobe, and Adobe Acrobat are registered trademarks of Adobe Systems, Incorporated.
MS-DOS is a registered trademark of Microsoft Corporation.
Intel and Pentium are registered trademarks of Intel Corporation.
ESMPRO and EXPRESSBUILDER are registered trademarks of NEC Corporation.
LSI Logic, its logo, iBBU, MegaRAID, and MegaRAID Storage Manager are trademarks or registered trademarks of LSI Logic, Inc. of the U.S.A.
Promise Technology, Inc., its logo, SuperTrak, SuperBuild(TM) Utility, and Web-based Promise Array Manager (WebPAM) are registered trademarks of Promise Technology Inc. of the U.S.A.
All other product, brand, or trade names used in this publication are the trademarks or registered trademarks of their respective trademark owners.

Revision 1.0 - November 2006

Copyright 2006
NEC Computers S.A.S.
Immeuble Optima
10 rue Godefroy
92821 Puteaux
France
All Rights Reserved
This page is deliberately left empty.
Preface

The User's Guide explains the MegaRAID Storage Manager™ utility used to configure the following controller cards:

- LSI Logic Embedded MegaRAID(tm)
- LSI Logic MegaRAID SAS 8480E
- LSI Logic MegaRAID SAS 8408E
- LSI Logic MegaRAID SAS 8300XLP
- LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB

The guide is intended for persons who are familiar with Windows functions and operation methods. For details on or unclear points on Windows operation, see Windows Online Help and manuals.

When using MegaRAID Storage Manager™, first read the User's Guide provided with the server as well.
Contents

1. Overview .................................................................................................................... 7
   1.1 MegaRAID Storage Manager™ ................................................................................ 7

2. Installing and Uninstalling MSM .............................................................................. 8
   2.1 MSM Operating Environment (Server Specifications) .............................................. 8
   2.2 Installing and Uninstalling MSM on the Server .................................................... 9
      2.2.1 Installing MSM to the Server ........................................................................ 10
      2.2.2 Uninstalling MSM from the Server ............................................................... 12
   2.3 MSM Operation Environment (Management PC) .................................................. 13
   2.4 Installing and Uninstalling MSM (Management PC) .............................................. 13
      2.4.1 Installing MSM to the Management PC ...................................................... 14
      2.4.2 Uninstalling MSM from the Management PC ............................................. 16

3. Operating MSM ........................................................................................................ 18
   3.1 Starting MSM ........................................................................................................... 18
      3.1.1 Controlling the MegaRAID Storage System with a Local/Remote Computer ... 19
   3.2 MSM Operating Screen .......................................................................................... 21
      3.2.1 Menu Bar ...................................................................................................... 22
      3.2.2 Physical/Logical View .................................................................................. 24
      3.2.3 Properties / Operations / Graphical View .................................................. 28
      3.2.4 Event Viewer ............................................................................................... 36
   3.3 Creating and Deleting a Logical Drive (Array) ....................................................... 37
      3.3.1 Creating a Logical Drive .............................................................................. 38
      3.3.2 Deleting a Logical Drive ............................................................................. 45
   3.4 Check Consistency Feature ...................................................................................... 46
      3.4.1 Executing the Check Consistency ................................................................. 46
      3.4.2 Canceling the Check Consistency ............................................................... 49
   3.5 Patrol Read Feature ................................................................................................. 50
      3.5.1 Manual Execution of Patrol Read ............................................................... 50
      3.5.2 Scheduling Patrol Read .............................................................................. 51
   3.6 Rebuild Feature ...................................................................................................... 53
      3.6.1 Hot-swap Rebuild ....................................................................................... 54
      3.6.2 Hot-spare Rebuild ....................................................................................... 55
   3.7 Reconstruction Feature ........................................................................................... 56
      3.7.1 Executing Reconstruction ............................................................................ 56
   3.8 Help .......................................................................................................................... 61

4. Miscellaneous Information ..................................................................................... 62
   4.1 Supported functions of MegaRAID Systems ............................................................ 62
   4.2 How to confirm the type of Hot Spare Disks ............................................................. 63

5. CAUTIONS AND RESTRICTIONS ........................................................................... 64
   5.1 Common Cautions and Restrictions for the MegaRAID Storage Systems ............... 64
   5.2 Cautions and Restrictions for the LSI Logic MegaRAID SAS 8480E and the LSI Logic
       MegaRAID SAS 8408E disk array controllers ..................................................... 67
   5.3 Cautions and Restrictions for the LSI Logic Embedded MegaRAID™ ....................... 69
1. Overview

1.1 MegaRAID Storage Manager™

MegaRAID Storage Manager™ (hereafter abbreviated to MSM) is an application that locally or remotely monitors and manages the MegaRAID Storage Systems.

The MegaRAID Storage Systems are listed below:
- LSI Logic Embedded MegaRAID™
- LSI Logic MegaRAID SAS 8480E
- LSI Logic MegaRAID SAS 8408E
- LSI Logic MegaRAID SAS 8300XLP
- LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB

MSM supports the following:
- Flexible system management
  MSM provides a system using MSM with N-to-1 management. In an environment enabling communication through TCP/IP, several systems can be remotely managed at the same time.
- Creation and suppression of the arrays (packs) listed below via a graphical user interface
  - RAID 0 (data striping with more than one hard disk drive)
  - RAID 1 (data mirroring with two hard disk drives)
  - RAID 5 (Data and parity striping with more than two hard disk drives)
  - RAID 1 spanning (Same as RAID10. Data mirroring and striping with more than three hard disk drives)
  - RAID 5 spanning (Same as RAID50. Data striping including parity and striping with more than five hard disk drives)

**IMPORTANT:**

The supported RAID Levels depend on the MegaRAID Storage Systems. Please check Section "4.1 Supported functions of MegaRAID Systems".

- Array consistency check feature
  MSM includes an array check consistency feature. MSM can also recover data automatically if the check consistency feature detects an inconsistency.
Auto array rebuild feature in array degrading
MSM supports both:

- an hot-spare rebuild executed at the insertion/removal of a disk, and
- an hot-spare rebuild using a hot-spare disk defined previously and used when the array shifts to degrading state.

**NOTE:** The hot-swap rebuild is available only in a system supporting hot-swap.

To start MSM, the display setup must be higher than 255 colors. If this is not the case, a popup requesting more than 255 colors appears and MSM does not start.

# 2. Installing and Uninstalling MSM

## 2.1 MSM Operating Environment (Server Specifications)

The following lists the hardware and software operating environments (server specifications) required to operate MSM:

- **Hardware**
  - Server supporting the following MegaRAID Storage Systems.
    - LSI Logic Embedded MegaRAID(tm)
    - LSI Logic MegaRAID SAS 8480E
    - LSI Logic MegaRAID SAS 8408E
    - LSI Logic MegaRAID SAS 8300XLP
    - LSI Logic MegaRAID(tm) SAS PCI EXPRESS(tm) ROMB
  - Remaining capacity in hard disk drive: 60MB or larger

- **Software** (depending on which operating systems are supported in each computer.)
  - Windows Server 2003 SP1 (32bit/64bit)
  - Windows Server 2003 R2 (32bit/64bit)
  - Windows XP Professional SP2 (32bit)
  - Windows XP Professional x64 Edition
2.2 Installing and Uninstalling MSM on the Server

This section describes the installation and uninstallation of MSM on a server equipped with the MegaRAID controller.

**IMPORTANT:**

Only users authorized as administrators are permitted to install and uninstall MSM.

As premised, the software must be supported by Server.

If a Windows Security Warning about "POPUP" appears, ignore it. This warning appears only once.

If a "Warning of Security" appears, choose "Yes" and proceed with the installation.

**NOTES:**

Installation of MSM in a server of custom installation model:
MSM may have been factory-installed.

Setting up the server with Express Setup
MSM can be installed using the "Express Setup" automatic installation tool stored in the EXPRESSBUILDER CD-ROM shipped with the server. If you start the seamless setup, a dialog box appears which allows you to specify the desired application. Select "MSM".

Install the MSM manually with the CD attached to the SAS Card when there is no MSM installer on the EXPRESSBUILDER CD.
2.2.1 Installing MSM to the Server

Install MSM as described in the following procedure:

1. Insert the EXPRESSBUILDER CD-ROM in your computer's optical disc drive.
2. Right-click [Software Setup] in the [Master Control Menu] that appears on the screen and click [MegaRAID Storage Manager].
   The [Selecting Installation or Uninstallation] dialog box appears. Select [Installation for MSM] and click [Next].

   If you want to change the installation destination folder, click [Browse], and follow the instructions in the dialog box that appears.
   If the directory is correct, click [Next].
4. The installation is started. When MSM has been installed, the [Setup finished] dialog box appears.

Select [Yes, I want to restart my computer now], and click [OK].

![Setup finished dialog box]

NOTE: After selecting system reboot at the termination of MSM installation, the background of the setup may remain as it is, rarely. If this occurs, follow the procedure below:


2. Terminate the [InstallShield - MSM] task.

3. If a dialog such as "1628: Script-base installation could not be completed" appears, click [OK] to close the dialog box.

Then reboot the system to complete the installation. Despite the operation, MSM has been installed normally.
2.2.2 Uninstalling MSM from the Server

Uninstall MSM as described in the following procedure:

**IMPORTANT:**

Do not uninstall MSM through [Add or Remove Applications] or [Add or Remove Programs] in the Control Panel. Always follow the procedure described in this section for the uninstallation.

The popup for warning as “Application is not running”, when uninstalling the MSM. Close this popup for warning, there is no problem.

1. Insert the EXPRESSBUILDER CD-ROM into your computer's optical disc drive.

2. Right-click [Software Setup] in the [Master Control Menu] appearing on the screen and click [MegaRAID Storage Manager]. Then the [Selecting Installation or Uninstallation] dialog box appears. Select [Uninstallation for MSM] and click [Next].

3. After a while, the [Uninstallation Confirmation] dialog box appears. Click [Yes].

4. Uninstallation of MSM starts. The [Setup Finished] dialog box appears when MSM has been uninstalled. Select [Yes, I want to restart my computer now], and click [OK].
2.3 MSM Operation Environment (Management PC)

The following shows the hardware and software operation environment (management PC specification) required to operate MSM:

- **Hardware**
  - PC:
    - Compatible server (contact to your sales representative)
    - PC/AT compatible machine (equipped with Intel Pentium III CPU or higher)
  - Remaining capacity in hard disk drive: 60MB or larger

- **Software**
  - Windows Server 2003 SP1 (32bit/64bit)
  - Windows Server 2003 R2 (32bit/64bit)
  - Windows 2000 SP4 (Server/WorkStation)
  - Windows XP Professional SP2 (32bit)
  - Windows XP Professional x64 Edition

2.4 Installing and Uninstalling MSM (Management PC)

This section describes the installation and uninstallation of MSM in a PC managing servers through a network.

**IMPORTANT:** Only users authorized as administrators are permitted to install and uninstall MSM.

**NOTES:**

For some servers of the custom installation model, MSM may previously be installed at their purchases.

Install the MSM manually with the CD which attached the SAS Card, when there is no MSM installer in the "EXPRESSBUILDER" CD.
2.4.1 Installing MSM to the Management PC

Install MSM as described in the following procedure:

1. Insert the EXPRESSBUILDER CD-ROM into your computer’s optical disc drive.
2. Run MSM.EXE contained in the following folder:
   \MSM\VIVA\MSM.EXE
3. The screen shown below appears. Click [Next].

![Screen shot 1](image1)

4. The screen shown below appears. Check [I accept the terms in the license agreement] and click [Next].

![Screen shot 2](image2)

5. The screen shown below appears. Check [All users] and click [Next].

![Screen shot 3](image3)
6. The screen shown below appears. Click [Next].
   To change the installation folder, click [Change] and specify a new installation folder.

7. The screen shown below appears. Select [Client] and click [Next].

8. The screen shown below appears. Click [Install].

9. The screen shown below appears. Click [Finish].

The installation is complete.
2.4.2 Uninstalling MSM from the Management PC

Uninstall MSM as described as described in the following procedure:

**IMPORTANT:**

Do not uninstall MSM through [Add or Remove Applications] or [Add or Remove Programs] in the Control Panel. Always follow the procedure described in this section for the uninstallation.

1. Insert the EXPRESSBUILDER CD-ROM into your computer's optical disc drive.
2. Run MSM.EXE contained in the following folder:
   \MSM\VIVA\MSM.EXE
3. The screen shown below appears. Click [Next].
4. The screen shown below appears. Check [Remove] and click [Next].
5. The screen shown below appears. Click [Remove].

![Remove screen](image)

6. The screen shown below appears. Click [Finish].

![Finish screen](image)

The application has been successfully uninstalled.
3. Operating MSM

This chapter describes how to start MSM and how to operate MSM.

The features supported by MSM depend on the MegaRAID Storage Systems Unsupported features are not shown in the MSM menu. See also Section "4.1 Supported functions of MegaRAID Systems" for more details.

3.1 Starting MSM

This section describes how to start MSM.

IMPORTANT:
Close any other MSM displays.

Depending on the operating system and/or color scheme you use, the screens appearing on your monitor may look different than the captures shown in this manual.

NOTE: If MSM is installed on a computer supporting a Windows firewall, the "Important warning on Windows security" window may appear against "javaw" at the start of MSM. In this case, select [Release block].
3.1.1 Controlling the MegaRAID Storage System with a Local/Remote Computer

To control MSM with local and/or remote computers, start MSM as described in the following procedure to display the array configuration screen.

**NOTES:**

To control MSM with a remote computer, MSM must also be installed in the remote computer.

MSM services must operate in any systems controlled by remote computers.

MSM cannot be controlled by a remote computer in which the firewall feature provided by the Windows operating system is active.

In this case, change the setting so that MSM can be controlled by the remote computer.

* MSM uses ports 3071 and 5571. MSM also temporarily uses any port numbers over 32000. Do not block these ports.

1. Select [Start] → [Programs] → [MegaRAID Storage Manager] and click [StartupUI].

2. Select the server to be controlled by a local and/or remote computer and click [Connect].

MegaRAID Storage systems belonging to a specific subnet are automatically displayed as candidates. For a connection extending over the subnet, enter the IP address in the text box at the bottom of the screen and click [Update]. If a MegaRAID Storage system is found in the server of the specified IP address, it will be displayed.
A circle icon appears on each host in the server selection screen. The host status is shown by one of the following colors:

- **Green:** Normal operation
- **Yellow:** Occurrence of disk array degrading
- **Red:** Occurrence of configuration error

3. Enter the following on the login screen.

- In the [Login Mode] field, select [Full Access] to change the array configuration or [View Only] to see the configuration only.
- In the [User name] field, specify the name of a user authorized as an administrator for the system.
- In the [Password] field, type the password of the user specified in the [User name] field.
- Click [Login].

**NOTES:**

If [Full Access] is selected, only a single can log in to the system.

If [Full Access] is selected, only a user authorized as an administrator can log in to the system.

The names of login users and their IP addresses are recorded in the MSM log.

**IMPORTANT:**

Only local users can be specified with an Administrators authority in the [User name] field. Domain users cannot login MSM as Administrators, regardless of their authorities.
3.2 MSM Operating Screen

An example of the MSM screen is shown below (once logged in, the screen shown below appears).

![MSM Screen Example]

MSM has four screen interfaces as follows:

1. Menu bar
2. Physical/Logical View
3. Properties/Operations/Graphical view
4. Event Viewer

The following operations are permitted for the above interfaces:

- A feature can be selected from the menu bar.
- On the Physical/Logical View, an object can be selected. Select an item on the object by right-clicking the object.
- On the Operations tab, a feature can be selected.
- On the Event Viewer, an event can be selected. Select an item on the event by right-clicking the event.
- The detailed information on an event can be displayed by double-clicking the event.

**NOTES:**

Grayed-out items are unavailable in the environment in which the menu is displayed.

Available menu items change depending on the MegaRAID Storage system that you are using.
3.2.1 Menu Bar

Selectable objects on the menu bar can also be selected/executed by right-clicking them.

The menu bar appears as follows:

| File | Operations | Group Operations | Log | Help |

The menus are described below.

- **[File] menu**

  On the [File] menu, you can select the following items.

  - **[Rescan]**:
    
    Rescans the arrays to acquire the array configuration information again.

  - **[Exit]**:
    
    Exits from MSM.

  **IMPORTANT:** Wait at least 60 seconds between 2 scans. If the interval is shorter, an unexpected event may occur.

- **[Operations] menu**

  When you select the [Operations] menu, the menu that appears is the same as when you right-click an object specified on MSM. The [Operations] menu changes depending on the focusing object.

- **[Group Operations] menu**

  On the [Group Operations] menu, you can select the following items:

  - **[Check Consistency]**:
    
    Executes the consistency check for the logical drives. Refer to "3.4.1 Executing the Check Consistency".

  - **[Initialize]**:
    
    Initializes the logical drives.

  - **[Show Progress]**:
    
    Allows you to check the progress of the on-going process or to abort the process.
■ [Log] menu
On the [Log] menu, you can select the following items:

[Save Log]:
Saves to a specified file the logs appearing in the Event Viewer.

[Clear Log]:
Clears the logs appearing in the Event Viewer.

[View Saved Log]:
Allows you to view the logs saved to a file with [Save Log].

■ [Help] menu
On the [Help] menu, you can select the following items:

[Help]:
Opens the help information. However, we recommend you refer to this manual which is much more complete.

[About]:
Shows the MSM version.
3.2.2 Physical/Logical View

On the Physical/Logical View, the physical and logical drives connected to the disk array controller are respectively displayed in the tree format.

If you put the cursor on a displayed object and right-click the object, then you can select and run an available feature. Menus displayed with a right-click are called “Context Menus”. The contents of a “Context Menu” depend on the available MegaRAID Storage System.

- **Menu displayed by right-clicking a Controller [Context Menu]:**
  The following shows a sample menu which may be displayed by right-clicking a Controller.

![Menu display](image)

**[Enable Alarm]:**
Enables the alarm feature.
The alarm beeps if a fault occurs in the disk array controller. The alarm continues until you select [Silence Alarm] described later.

**[Disable Alarm]:**
Disables the alarm feature.
No alarm sounds if a fault occurs in the disk array controller.

**[Silence Alarm]:**
Stops the alarm when it is beeping.

**[Start Patrol Read / Stop Patrol Read]:**
Starts/stops the Patrol Read feature.
The screen display varies depending on the execution status of the Patrol Read feature.

**[Advanced Operations] → [Configuration]**

→ **[Configuration Wizard]:**
Creates a logical drive. Refer to Section "3.3.1 Creating a Logical Drive".

→ **[Add Configuration from file]:**
Recover the saved configuration.

→ **[Save Configuration]:**
Saves the configuration on a hard disk drive or floppy disk.

→ **[Clear Configuration]:**
Clears the information on the disk array configuration.
[Scan For Foreign Config]:
Reads configuration info from the HDD and tries to rebuild an array by using that info.
This feature is not supported. Do not use the feature.

- **Menu appearing when right-clicking a physical drive [Context Menu]**:
The following shows a sample menu which may be displayed by right-clicking a physical drive. Sample menus are shown below in physical drive states.

**When a physical drive operates normally:**

![Sample Menu](image)

[Make Drive Offline]:
Makes the physical drive offline.
This feature is dedicated for maintenance. Do not use the feature.

[Locate Physical Drive]:
Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
Makes the physical disk LED stop blinking.

**When a physical drive is being rebuilt:**

![Sample Menu](image)

[Abort Rebuild]:
Aborts the rebuild process.

[Locate Physical Drive]:
Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
Makes the physical disk LED stop blinking.
When a physical drive is in offline status:

- [Make Drive Online]:
  Makes the physical drive online.
  The feature is dedicated for maintenance. Do not use the feature.

- [Mark Physical Drive as Missing]:
  This feature is not supported yet. Do not use the feature.

- [Rebuild]:
  Starts the rebuild process.

- [Locate Physical Drive]:
  Makes the physical disk LED blink.

- [Stop Locating Physical Drive]:
  Makes the physical disk LED stop blinking.

When a physical drive is a hot-spare disk:

- [Locate Physical Drive]:
  Makes the physical disk LED blink.

- [Stop Locating Physical Drive]:
  Makes the physical disk LED stop blinking.

- [Remove Hotspare]:
  Releases the hot-spare disk setting.

When a physical drive is not used yet:

- [Locate Physical Drive]:
  Makes the physical disk LED blink.
[Stop Locating Physical Drive]:
    Makes the physical disk LED stop blinking.

[Make Global Hotspare]:
    Creates a Global hot-spare disk.

[Prepare For Removal]/ [Undo Prepare For Removal]:
    Do not use the feature. This functionnality stops and restarts the revolution of the spindle motor of the HDD, but this operation is not required for an HDD exchange.

Menu appearing when right-clicking a Virtual Disk [Context Menu]:
The following shows a sample menu which may be displayed by right-clicking a physical drive. Sample menus are shown below in physical drive states.

When a logical drive operates normally:

[Delete Virtual Disk]:
    Deletes the logical drive.

[Locate Physical Drive]:
    Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
    Makes the physical disk LED stop blinking.

[Check Consistency]:
    Checks the logical drive consistency.

[Advanced Operations]
    → [Reconstruction Wizard]:
    Increases the capacity of the existing array or changes the RAID level.

Refer to Section "3.7.1 Executing Reconstruction".

IMPORTANT: When you use the LSI Logic MegaRAID SAS 8480E with the NEC Storage ST1220, the HDD order displayed in MSM differs from the HDD order on the Disk Expansion Unit. In this case, use the "Locate Virtual Disk" feature to identify a specific hard disk drive.
When a logical drive is degraded:

[Check Consistency] is unavailable. It is displayed only when the logical drive operates normally.

When a logical drive is subject to a consistency check or a rebuild process:

- [Delete Virtual Disk]: Deletes the logical drive.
- [Locate Physical Drive]: Makes the physical disk LED blink.
- [Stop Locating Physical Drive]: Makes the physical disk LED stop blinking.
- [Cancel Check Consistency] (only during a consistency check): Cancels the consistency check.

### 3.2.3 Properties / Operations / Graphical View

The Properties/Operations/Graphical view indicates:

- the information on the controllers and drives selected in the Physical/Logical View of the Properties view,
- the setups/executions of the available features in the Operations view,
- and the capacities of the graphical drives in the Graphical view.

- **Properties**
  Indicates some information on the selected controllers and drives.

- **Operations**
  Allows you to set or execute the features available for the selected controllers and drives.

**IMPORTANT:** Setup/execution of a feature

To setup/execute a feature on the Operations view, select the desired feature from the menu shown to the left, change the setting on the window shown to the right if necessary and select [Go].

The menu displayed in the Operations view varies depending on the states of the selected objects and/or drives. Sample menus are shown below.
When a controller is selected:

[Enable Alarm]: Enables the alarm feature.

[Disable Alarm]: Disables the alarm feature.

[Silence Alarm]: Stops the alarm when it is beeping.

[Flash Firmware]: Updates the firmware of the controller.
This operation is dedicated for maintenance. Do not use the feature.

[Set Patrol Read Properties]: Allows you to set the Patrol Read schedule. Refer to Section "3.5.2 Scheduling Patrol Read".

[Start Patrol Read / Stop Patrol Read]: Starts or stops the Patrol Read.
The screen display varies depending on how the Patrol Read is executed. Refer to Section "3.5.1 Manual Execution of Patrol Read".

[Set Adjustable Task Rates]: Specifies the preferential assignment of the system processing capacity with a value between 0% and 100% when the rebuild, Patrol Read, or check consistency feature is executed.

Specifying a higher value allows the system processing capacity to be used more preferentially.

Specifying a lower value causes the system performance during rebuild to remain only in a lower level.

This sets the priority against other processes. With 0%, the feature can also operate. Similarly, with 100%, other processes are not automatically interrupted.
When a physical drive is selected (in normal state):

[Make Drive Offline]:
  Makes the physical drive offline.
  This feature is dedicated for maintenance. Do not use the feature.

[Locate Physical Drive]:
  Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
  Makes the physical disk LED stop blinking.

When a physical drive is selected (during a rebuild process):

[Abort Rebuild]:
  Aborts the rebuild process.

[Locate Physical Drive]:
  Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
  Makes the physical disk LED stop blinking.
When a physical drive is selected (in offline status):

[Make Drive Online]:
Makes the physical drive online.
This feature is dedicated for maintenance. Do not use the feature.

[Mark Physical Drive as Missing]:
This feature is not supported yet. Do not use the feature.

[Rebuild]:
Starts the rebuild process.

[Locate Physical Drive]:
Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
Makes the physical disk LED stop blinking.

When a physical drive is selected (being hot-spare disk):

[Remove Hotspare]:
Releases the hot-spare disk setting.

[Locate Physical Drive]:
Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
Makes the physical disk LED stop blinking.
When a physical drive is not used yet:

[Locate Physical Drive]:
  Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
  Makes the physical disk LED stop blinking.

[Make Global Hotspare]:
  Creates a Global hot-spare disk.

[Make Dedicated Hotspare]:
  Creates a hot-spare disk operating only for the specified array.

[Prepare For Removal]/ [Undo Prepare For Removal]:
  Do not use the feature.

  Do not use the feature. This functionality stops and restarts the revolution of the spindle motor of the HDD, but this operation is not required for an HDD exchange.
When a logical drive is selected (in normal state):

[Delete Virtual Disk]:
   Deletes the logical drive.

[Locate Physical Drive]:
   Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
   Makes the physical disk LED stop blinking.

[Check Consistency]:
   Checks the logical drive consistency.

[Start Initialization]:
   Initializes the logical drive.

[Set Virtual Disk Properties]:
   Allows you to set the read and/or write policies of the logical drive.

When a logical drive is selected (degraded or during a rebuild process):

[Check Consistency] and [Start Initialization] are disabled (removed from the menu) in the above screen.
When a logical drive is selected (during the execution of a consistency check):

[Delete Virtual Disk]:
Deletes the logical drive.

[Locate Physical Drive]:
Makes the physical disk LED blink.

[Stop Locating Physical Drive]:
Makes the physical disk LED stop blinking.

[Cancel Check Consistency]:
Cancels the consistency check.

[Set Virtual Disk Properties]:
Allows you to set the read and/or write policies of the logical drive.
- **Graphical View**

  Indicates graphically the capacity of the selected drive.

  The following shows sample displays for physical and logical drives.

  **Sample display for a physical drive**

  If you select a logical drive from the [Select Virtual Disk (VD)] list as shown in the figure on the left figure, you can check the area in which physical drives are used for the selected logical drive as shown in the figure on the right.

  ![Sample display for a physical drive](image1)

  **Sample display for a logical drive**

  ![Sample display for a logical drive](image2)
3.2.4 Event Viewer

The Event Viewer indicates the log information acquired since the server was started.

- Right-click on the Event Viewer.

  [Save Log]:
  Saves to a specified file the logs appearing in the Event Viewer.

  [Clear Log]:
  Clears the logs appearing in the Event Viewer.

  [View Saved Log]:
  Allows you to view the logs saved to a file with [Save Log].

NOTES:

There are two types of logs on the MSM log viewer.

xxxxxx seconds from reboot: "Relative time since rebooting"

MSM logs are registered according to the following rules.
- Events which occurred after the operating system started are shown as "Actual time".
- Events which occurred before the operating system started are shown as "Relative Time".

Check the Application Log of the System Event Logs to see "Relative time" as "Actual time".
3.3 Creating and Deleting a Logical Drive (Array)

This section explains how to create and delete logical drives. To create logical drives, do not reuse failed HDDs. Always use new HDDs.

MSM allows the creation of the following logical drives:

- RAID 0 (data striping with more than one hard disk drive)
- RAID 1 (data mirroring with two hard disk drives)
- RAID 5 (data striping including parity with more than two hard disk drives)
- RAID 1 spanning (same as RAID10. Data mirroring and striping with more than three hard disk drives)
- RAID 5 spanning (same as RAID50. Data striping including parity and striping with more than five hard disk drives)

**NOTES:**

Do not use the following hard disk drives to create a logical drive.

- Hard disk drive with partitions
- Hard disk drive used for another array

During the creation of a logical drive, do not shutdown the system, and do not insert or remove a hard disk drive until the creation process is completed.

Available RAID level depend on the MegaRAID Storage System. Refer to "4.1 Supported functions of MegaRAID Systems" for more information.
3.3.1 Creating a Logical Drive

Use the Configuration Wizard to create a logical drive. Right-click the controller in the Physical/Logical View and click [Advanced Operations] → [Configuration] → [Configuration Wizard].

Select either Auto Configuration, Manual Configuration or Guided Configuration.

[Auto Configuration]:
Creates automatically a draft of the logical drive configuration according to the status of the unused hard disk drives.

[Manual Configuration]:
Creates a logical drive according to a specific request.

[Guided Configuration]:
Creates a logical drive by specifying sequentially the setting items.

The selection buttons commonly displayed on the logical drive creation screen are as follows:

[Cancel]: Cancels the logical drive creation process.
[Back]: Returns to the previous screen.
[Next]: Goes to the next screen.
[Finish]: Creates a logical drive.

The following sections describe the different logical drive creation procedures.
3.3.1.1 Auto Configuration

The auto configuration mode allows the draft of the logical drive configuration to be created automatically depending on the status of the unused hard disk drives.

The setting procedure is described below.


2. The array configuration draft is automatically created.
   To create a redundant array configuration, select [With Redundancy] in [Redundancy Type].
   To edit the array configuration, click [Modify].
   The menu that appears when [Modify] is selected is the same as that in Step 3 of the manual configuration. Refer to Step 3 in the manual configuration for more information.

Initialization Type

[No Initialization]:
   Does not initialize the logical drive once it has been created. Do not specify this option.

[Fast Initialization]:
   Does a simple initialization. This option initializes only the management information of the array.

[Full Initialization]:
   Completely initializes the logical drive once it has been created. You should use this option whenever possible.
Redundancy Type

[No Redundancy]:
Does not provide a redundant array configuration.

[With Redundancy]:
Provides a redundant array configuration.

3. Click [Finish] to create a logical drive.

3.3.1.2 Manual Configuration

The manual configuration mode allows the creation of a logical drive according to a specific request. The setting procedure is described below.


2. Select a physical drive from the Unconfigured Physical Drive List and click the button to add the physical drive to the Arrays with Available Space.
   To recover the added physical drive, select the physical drive and click the button.

[Add Hotspare To]:
Sets the physical disk as the hot-spare disk operating only for the specified array.

[Remove HotSpare]:
Releases the hot-spare disk setting.

3. Click [Accept]. Then click [Next].
4. Set appropriately the parameters in Virtual Disk Properties and click [Accept]. Then click [Next].

- **[RAID Level]**: Selects the array RAID level.
- **[Size (in MB)]**: Sets the capacity of the logical drive to be created.
- **[Volume ID]**: Leaves the initial setting value unchanged.
- **[Volume Name]**: Specifies the name of the logical drive.
- **[Stripe Size]**: Selects the unit of data distributed to each hard disk drive configuring RAID out of 8K, 16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes. LSI Logic Embedded MegaRAID(tm) is always 64K bytes.
- **[Read Policy]**: Selects No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default setting is No Read Ahead.
- **[Default Write Policy]**: Selects either Write Through or Write Back. The default setting is Write Back.
- **[IO Policy]**: Selects either Direct IO or Cached IO. The default setting is Direct IO.
- **[Access Policy]**: Selects Read Write, Read Only, or Blocked. The default setting is Read Write.
- **[Disk Cache Policy]**: Selects Unchanged, Enabled or Disabled. The default setting is Unchanged.
- **[Init State]**: Selects the logical drive initialization procedure out of No Initialization, Fast...
Initialization and Full Initialization. The default setting is No Initialization.

**NOTE:** Depending on the disk array controller you use, some setting values may be restricted for stable system performance and operation. Refer to the manuals coming with the LSI Logic MegaRAID SAS 8480E, the LSI Logic MegaRAID SAS 8408E and the server.

Check the contents of the array to be configured, and click on [Finish]. Then the logical drive is created.
3.3.1.3 Guided Configuration

The guided configuration mode allows to create a logical drive by specifying sequentially the setting items.

The setting procedure is described below.


2. Select the [Redundancy] and [Existing Arrays] options and specify the number of logical drives to be created in [Desired Number of Virtual Disks]. Click [Next].

**Redundancy**

[Redundancy Only]:

 Creates a redundant array configuration.

[Redundancy when possible]:

 Tries to create a redundant array configuration. If it is not possible, creates a non-redundant array configuration.

[No Redundancy]:

 Creates a non-redundant array configuration.

**Existing Arrays**

[Use Existing Arrays Only]:

 Uses the existing arrays only.

[Don’t use Existing Arrays]:

 Does not use the existing arrays.

[Use Existing and New Arrays]:

 Uses both existing and new arrays.
3. Specifies the number of logical drives to be created for each RAID and its capacity in Virtual Disk Count and Total Capacity, respectively. Set the relevant parameters in the Virtual Disk Properties and click [Next].

[Stripe Size]:
Selects the unit of data distributed to each hard disk drive configuring RAID out of 8K, 16K, 32K, 64K, and 128K bytes. The default setting is 64K bytes.
LSI Logic Embedded MegaRAID(tm) is always 64K bytes.

[Read Policy]:
Selects No Read Ahead, Adaptive Read Ahead, or Always Read Ahead. The default setting is No Read Ahead.

[Default Write Policy]:
Selects either Write Through or Write Back. The default setting is Write Back.

[IO Policy]:
Selects either Direct IO or Cached IO. The default setting is Direct IO.

[Access Policy]:
Selects Read Write, Read Only, or Blocked. The default setting is Read Write.

[Disk Cache Policy]:
Selects Unchanged, Enabled or Disabled. The default setting is Unchanged.

[Init State]:
Selects the logical drive initialization procedure out of No Initialization, Fast Initialization and Full Initialization.
The default setting is No Initialization.

**NOTE:** Depending on the disk array controller you use, some setting values may be restricted for stable system performance and operation. Refer to the manuals coming with the LSI Logic MegaRAID SAS 8480E, the LSI Logic MegaRAID SAS 8408E and the server.
4. Check the contents of the array to be configured, and click [Finish] to create the logical drives.

To edit the array configuration, click [Modify].

The menu that appears when [Modify] is selected is the same as that in Step 3 of the manual configuration. Refer to Step 3 in the manual configuration for more information.

3.3.2 Deleting a Logical Drive

You can delete a logical drive as described in the following procedure:

1. Select the logical drive to be deleted in the Logical view.
2. Click [Operations] → [Delete Virtual Disk] on the menu bar.
4. The selected logical drive is deleted from MSM.

IMPORTANT: A logical drive deleted by mistake cannot be recovered. Before deleting a logical drive, make sure that it can be deleted.
3.4 Check Consistency Feature

The check consistency feature checks the consistency and automatically corrects the data if an inconsistency is detected.

**IMPORTANT:** The Check Consistency function and the Patrol Read function allow you to find the defects (due to degradations such as aging) in files unfrequently accessed and unused areas as soon as possible. When rebuilding after the replacement of a HDD due to a failure, subsequent defects may be found in remaining HDDs, and in this case, the system cannot be recovered. Detecting subsequent defects as early as possible is consequently extremely effective as preventive maintenance. Periodical synchronization or media patrol is effective to keep the stable operation of your system. We strongly recommend using this feature once per week or at least once per month.

3.4.1 Executing the Check Consistency

Execute the check consistency as described in the following procedure.

**Check consistency execution procedure**

The check consistency can be started using any of the following three ways.

- Menu bar
- Context menu (displayed with a right-click)
- [Operations] tab

The check consistency proceeds as described below.
Starting the execution using the menu bar

1. Select [Group Operations] → [Check Consistency] on the menu bar.
2. Check one or more logical drives to be checked in [Select Virtual Disks] and click [Start].

![Screenshot of the Group Consistency Check window]

[Select All]:
Checks all the logical drives.

[Deselect All]:
Unchecks all the logical drives.

3. The check consistency check is executed.
Click the [×] button at the upper right corner of the screen to close it.
Select [Group Operations] → [Show Progress] on the menu bar to view the execution progress.

Starting the execution using a Context Menu (right-click)

1. Select a logical drive on the [Logical] tab and right-click it.
2. Select [Check Consistency] on the context menu.

![Screenshot of the Logical tab and context menu]

3. The consistency check is executed.
Select [Group Operations] → [Show Progress] on the menu bar to view the execution progress.
Starting execution on [Operations] tab

1. Select a logical drive on the Logical view and select the [Operations] tab.
2. Check [Check Consistency] and click [Go].
3. The consistency check is executed.
   Select [Group Operations] → [Show Progress] on the menu bar to view the execution progress.
3.4.2 Canceling the Check Consistency

Cancel the check consistency as described in the following procedure.

Check consistency canceling procedure

1. Select [Group Operations] → [Show Progress] on the menu bar.
2. The Group Show Progress screen appears.
   Click [Abort] to the right of the progress indication.

   [Abort All]:
   With more than one logical drive being subject to the check consistency, cancels the check consistency for all the logical drives
3. Cancel the consistency check.
   Click the [×] button at the upper right corner of the Group Show Progress screen to close it.
3.5 Patrol Read Feature

The Patrol Read feature operates in physical drives configuring all arrays including hot-spare disks to detect errors and recover the system from the errors if they are detected.

**IMPORTANT:** The Check Consistency function and the Patrol Read function allow you to find the defects (due to degradations such as aging) in files unfrequently accessed and unused areas as soon as possible. When rebuilding after the replacement of a HDD due to a failure, subsequent defects may be found in remaining HDDs, and in this case, the system cannot be recovered. Detecting subsequent defects as early as possible is consequently extremely effective as preventive maintenance. Periodical synchronization or media patrol is effective to keep the stable operation of your system. We strongly recommend using this feature once per week or at least once per month.

3.5.1 Manual Execution of Patrol Read

Execute the Patrol Read manually as described in the following procedure.

**Patrol Read execution procedure**

1. Select a controller on the Physical/Logical View, and click [Operations] → [Start Patrol Read] on the menu bar.

2. If the confirmation dialog shown below appears, click [Yes].

   The Patrol Read is executed.
To interrupt the Patrol Read, click [Operations] → [Stop Patrol Read].

3.5.2 Scheduling Patrol Read

The Patrol Read can be scheduled as described in the following procedure.

Patrol Read scheduling procedure

1. Select a controller on the Physical/Logical View, and select [Operations].
2. Check [Set Patrol Read Properties].
3. The schedule setting screen shown below appears. Change the Operation Mode to [Auto]. If [Auto] is already selected, do not make any changes.

[Auto]:
Executes the Patrol Read scheduling.

[Manual]:
Disables the scheduled execution of the Patrol Read and enables the manual execution.

[Disabled]:
Disables the Patrol Read.
4. Change the following items to the values of your choice and click [Go].

[Maximum PD Count for patrolling]:

Sets the maximum number of physical drives for which the Patrol Read is to be executed.

Do not change the default value (255).

[Continuous Patrolling]:

This feature is not supported yet. Do not check it.

[Select Excluded Virtual Disks]:

Check the logical drives that you wish to exclude from the Patrol read. To execute the Patrol Read for all logical drives, do not check any drives.

[Execution Frequency]:

Specifies the interval at which the Patrol Read is executed.

You can set the interval in hours, minutes, or seconds.

---

NOTES:

If you shutdown the server during a manual Patrol Read, it is aborted. Execute the Patrol Read again when the server is started.

If you shutdown the server during a scheduled Patrol Read, it will restart from the beginning when the server is rebooted.
3.6 Rebuild Feature

The rebuild feature can recover a degraded array. Replace the defective hard disk drive with a functional hard disk drive before using the feature.

The rebuild can be done in three different ways.

[Hot-swap rebuild]:
The rebuild begins when the defective hard disk drive is replaced during system operation with a normal hard disk drive.

[Hot-spare rebuild]:
The rebuild begins automatically using the spare disk.
Hot-spare disks can be of two different types.
- Global Hot-spare, used for all arrays.
- Dedicated Spare, used for specified arrays.

[Rebuild from MSM]:
The rebuild begins when [Rebuild] is selected from the context menu that is displayed when right-clicking on the defective hard drive.
Because the feature uses the defective hard disk drive for the array recovery, the rebuild may fail or the array may be degraded immediately after it is recovered.
Accordingly, it does not secure the operation after the rebuild.

The hot-swap and hot-spare rebuild operations are described afterwards.

---

NOTES:

Do not use the hot-swap feature during the array rebuild operation.
To enable rebuild, the disk capacity of the new hard disk drive should be equal to or larger than the disk capacity of the defective hard disk drive.
3.6.1 Hot-swap Rebuild

Perform a hot-swap rebuild as described in the following procedure:

1. Find the defective hard disk drive. The following figure shows a sample display in MSM.

![Sample Display in MSM](image)

The icon ![Degraded Logical Drive](icon) shows a degraded logical drive.
The icon ![Defective Hard Disk Drive](icon) shows a defective hard disk drive.

2. Pull out the defective hard disk drive.

3. Insert a new hard disk drive into the slot from which you removed the defective hard disk drive. The rebuild operation starts.

![Hard Disk Drive Being Rebuilt](image)

The icon ![Hard Disk Drive Being Rebuilt](icon) shows the hard disk drive being rebuilt.

Select [Group Operations] → [Show Progress] on the menu bar to view the progress of the process.

**IMPORTANT:** When replacing a hard disk drive using the hot-swap feature, wait at least 60 seconds between the removal of the defective hard disk drive and the installation of the substitute hard disk drive. A shorter interval may cause an unexpected event to occur.
3.6.2 Hot-spares Rebuild

3.6.2.1 Hot-spares Disk Setting Procedure

Global hot-spares setting procedure

1. Identify an unused hard disk drive shown on the Physical view and right-click it.
3. The hard disk drive is set as a hot-spare disk.

Dedicated hot-spares setting procedure

1. Select an unused hard disk drive shown on the Physical view. Select [Operations].
2. Check [Make Dedicated Hotspare].
3. The array selection screen shown below appears. Check the array in Select array and click [GO].

![Array Selection Screen]

**IMPORTANT:** The hot-spare disk must have a capacity larger than or equal to that of the hard disk drive configuring the array. If the hard disk drive has a lower capacity, the hot-spare build feature cannot work.

3.6.2.2 Release of Hot-spares Disk Setting

1. Select a hot-spare disk and right-click it.
2. Select [Remove Hotspare] from the context menu.
3. When prompted for confirmation, select [Yes]. If you select [No], the release process is cancelled.
4. The hot-spare disk setting is released. The released disk is an unused hard disk drive.
3.7 Reconstruction Feature

The reconstruction feature allows you to increase the capacity of an existing array and/or change its RAID level.

**IMPORTANT:**

Execution of reconstruction
- We recommend you backup the partitions on a logical drive before adding capacity to an array (in case an unexpected event should occur).
- The reconstruction cannot be cancelled once it is started.

**NOTE:** The reconstruction feature is only available under the following condition:
- Configure only a single logical drive in the array (the reconstruction feature is unavailable if more than one logical drive are configured in the array).

3.7.1 Executing Reconstruction

To execute the reconstruction, right-click the relevant logical drive on the Logical view, click [Advanced Operations] → [Reconstruction Wizard] and select [Yes] when prompted to do so.

The Reconstruction Wizard can also be displayed by selecting the relevant logical drive on the Logical view and clicking [Operations] → [Advanced Operations] → [Reconstruction Wizard] on the menu bar.
The reconstruction is divided into three types; Add Drive, Remove Drive and Change RAID Level.

[Add Drive]:
Adds a physical drive to the logical drive to increase the array capacity.

[Remove Drive]:
Removes the physical drive from the logical drive and converts the RAID level to RAID 0.

[Change RAID Level]:
Converts the RAID level to RAID 0.

3.7.1.1 Add Drive

This feature adds a physical drive to the logical drive to increase the array capacity. The procedure is described below.


2. Select the physical drive to be added from the upper list and click the button to move the physical drive to the lower list. Click [Next].
3. The physical drive to be added appears in red. Select the RAID level after the expansion from [New RAID Level] and click [Finish].

4. The confirmation message appears. Select [Yes]. If you select [No], the Add Drive feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to view the execution progress.

**IMPORTANT:** Add HDDs one at a time. If you need to add several HDDs, complete the addition of each HDD and then start the Add Drive feature again.

The "Add Drive" feature increases the capacity of array, but does not increase the capacity of the partition recognized by the operating system. If you want to increase the partition size, you need to create a new partition. We recommend you backup the logical drive partitions before creating a new partition.
3.7.1.2 Remove Drive

This feature removes the physical drive from the logical drive and converts the RAID level to RAID 0. The procedure is described below.


2. Select the physical drive to be removed from the upper list and click the button to move the physical drive to the lower list. Click [Next].

3. The physical drive to be removed appears in red. After checking the information, click [Finish].

4. The confirmation message appears. Select [Yes]. If you select [No], the Remove Drive feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to view the execution progress.
3.7.1.3 Change RAID Level

This feature converts the RAID level to RAID 0.

The procedure is described below.


2. Select RAID 0 from New RAID Level and click [Finish].

3. The confirmation message appears. Select [Yes].
   If you select [No], the Change RAID Level feature is cancelled.

Select [Group Operations] → [Show Progress] on the menu bar to view the progress of the execution progress.
3.8 Help

Selecting [Help] → [Help] on the menu bar displays the MSM help.

**NOTE:** The MSM help includes features not supported by your server or your adapter cards. Refer to this manual for the supported features.

Version confirmation procedure

Selecting [Help] → [About] on the menu bar allows you to see the MSM version. If you select [Server Info], the information on the server appears as shown below.
4. Miscellaneous Information

4.1 Supported functions of MegaRAID Systems

The functions supported by MSM depend on the MegaRAID Systems. See below for detail.

√ : Supported.

<table>
<thead>
<tr>
<th>MegaRAID Systems</th>
<th>Function (+1)</th>
<th>Embedded MegaRAID</th>
<th>LSI Logic MegaRAID SAS 8480E / 8408E</th>
<th>LSI Logic MegaRAID SAS 8300 XLP</th>
<th>ROMB</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI/Operation</td>
<td>Menu Bar</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Physical/Logical View</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Properties/Operations/Graphical View</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Events Viewer</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Supported Array Level (*2)</td>
<td>0, 1, 10, 5, 50</td>
<td>0, 1, 10, 5, 50</td>
<td>0, 1, 10, 5, 50</td>
<td>0, 1, 10, 5, 50</td>
<td></td>
</tr>
<tr>
<td>Making &amp; Deleting Logical Drives</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Check Consistency</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Patrol Read</td>
<td>Manual Operation</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Scheduled Operation</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Rebuild</td>
<td>Hot Swap Rebuild</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Hot Spare Rebuild</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Hot Spare</td>
<td>Global Hot Spare</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Dedicated Hot Spare</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Physical Disk</td>
<td>Locate Physical Drive</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Logical Disk</td>
<td>Locate Virtual Disk</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Misc.</td>
<td>Alarm</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Flash Firmware</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Browse &amp; Save Logs</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Remote Function</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>

*1 : Depends on RAID driver or RAID firmware.
*2 : Depends on Server.
4.2 How to confirm the type of Hot Spare Disks

You can confirm the type of Created Hot Spare Disks using MSM.

There are 2 types of Hot Spare Disk: "Global Hot Spare Disk" and "Dedicated Hot Spare Disk".

**How to confirm**

- **Global Hot Spare Disk**
  - "Global Hot Spare Disk" is shown on Physical View, but not shown on Logical View.

- **Dedicated Hot Spare Disk**
  - "Dedicated Hot Spare Disk" is shown on both of Physical and Logical View.

**Sample**

1. Start up MSM.

2. Show Physical View. Check Hot Spare Disk icon ( ).
   - There are 2 types of Hot Spare Disks: "Global Hot Spare Disk" and "Dedicated Hot Spare Disk" (marked red frame).

3. Show Logical View. Check Hot Spare Disk icon ( ). There is only "Dedicated Hot Spare Disk" (marked red frame).
5. CAUTIONS AND RESTRICTIONS

5.1 Common Cautions and Restrictions for the MegaRAID Storage Systems

Installing / uninstalling of MSM

- MSM temporarily uses a dynamic port number (49152 or above) during the installation. MSM automatically releases the port once MSM is installed.
- If MSM is installed on a computer supporting a Windows firewall, the "Important warning on Windows security" window may appear against "javaw" at the start of MSM. In this case, select [Release block].
- A Windows Security Warning may appear about “POPUP” when installing MSM. Ignore it, the warning message is no longer shown after system reboot.
- A "warning of security" dialog box may be displayed during the "Standby/Hibernation Lock" driver installation during the MSM installation. In this case, select "Yes" to continue the installation.
- To control MSM using a remote computer, MSM must be installed on both the local and remote computers.
- A Popuplog.log file is created in C: drive at the time of MSM installation. This file is not used after the reboot, and can be deleted.

MSM operation

- The MSM client cannot start until the MSM related service has completely started. If you start a MSM client before starting the service, the next error is indicated. "Fatal Error:Cannot connect to Framework!"
The MSM related service is the following.
  - Service Name: MegaMonitorSrv, Display Name: MRMonitor
  - Service Name: MSMFramework, Display Name: MSMFramework
- If you select [Replace Missing Physical Drive] in [Operations], a pull-down menu without options appears in the frame on the right. Do not use the feature.
- The firewall function which is provided by the Windows operating systems disturbs the remote function of MSM. Change the setting when using the remote function of MSM. Review the port settings for the firewall.
- MSM uses port numbers 3071 and 5571. You cannot change these port numbers.
- MSM temporarily uses port numbers over 32000.
- Concurrent accesses by both MSMs in local and remote computers are possible. However, only a single MSM can have the full access authority. If the full access authority cannot be selected in the login mode, check whether another client already uses this access. Review the MSM log to identify accesses from other clients.
- Only local users can be set as Administrators member in the "User Name" field of the MSM login window. You cannot specify domain users with Administrator rights.
- MSM cannot be used if there is no MegaRAID Storage System on the same LAN.
- MSM cannot be used when the target server has several ports which belong to different sub-nets. In this case, please use MSM in the target server.
- When you use the LSI Logic MegaRAID SAS 8480E with a Disk Expansion Unit, 5 ports may appear to be used in the "Physical View" of MSM. This is a display problem, only 4 ports are used.
- Wait at least 60 seconds between scans. If the interval is shorter, an unexpected event may occur.
- Do not use the "Prepare For Removal" and "Undo Prepare For Removal " options. These functionnalities stop and restart the revolution of the spindle motor of the HDD, but this operation is not required for an HDD exchange.
- The context menu of “Port” cannot be used, even if it is displayed.

**Creating or deleting logical drives**

- Specify the maximum capacity (default value) for RAID 1 spanning (RAID 10) or RAID 5 spanning (RAID 50) if you specify a capacity when creating a logical drive. Do not change the capacity.
- When creating a logical drive, do not use the following hard disk drives.
  - Hard disk drive with partitions
  - Hard disk drive used for another array
- Do not perform the following actions while a logical drive is being created:
  - Shut down the system
  - Insert hard disk drive(s)
  - Remove hard disk drive(s)

**Rebuild feature**

- Do not use the hot-swap feature during a rebuild process.
- When rebuilding using the hot-swap feature, wait at least 60 seconds between the removal of the defective hard disk drive and the installation of a substitute hard disk drive.
- Do not use the following hard disk drives as hot-spare disks. Use either new hard disk drives or hard disk drives already formatted.
  - Hard disk drive with partitions
  - Hard disk drive used for another array

**Patrol Read feature**

- The Patrol Read feature is aborted when the server is restarted. It starts again from the beginning once the server is restarted.
The status shows "Complete" even when you stop an ongoing Patrol Read.

**Miscellaneous**

- We recommend you periodically perform a "Check Consistency" or "Patrol Read" to detect defects due to HDD failures.
- Note that the icons of events reported by the NEC ESMPRO report feature are all displayed in green on NEC ESMPRO (they look like information events).
- If the [Save] dialog is displayed by selecting [Save Log] on the [Log] menu, the [Desktop] folder is displayed incorrectly in Japanese Environment. To save a log, specify a folder other than [Desktop].
- To start MSM, the display setup must be higher than 255 colors. If this is not the case, a popup requesting more than 255 colors appears and MSM does not start.
- If you display the dialog for [Save Log] and select [Detail], the information on [Type] will be garbled in Japanese environment. To check the [Type] displayed in the save log operation, use the Windows Explorer.
- When restarting MSM, the messages displayed in the MSM screen may disappear. Use the [Save Log] feature of MSM or check the messages registered in the Windows application log.
- Restart MSMFramework Service after changing the IP of the server system.
5.2 Cautions and Restrictions for the LSI Logic MegaRAID SAS 8480E and the LSI Logic MegaRAID SAS 8408E disk array controllers

MSM Operation

- "Date/Time" of MSM Logs is sometimes shown as "xx seconds from reboot". In this case, please check the Application Log of System Events.

- If no additional battery is attached, the following message is output by the MSM log and the event log (application), even if Write Thru is set in Write Policy.

```
[ MSM Log ]
Controller ID:x BBU disables; changing WB logical drivers to WT.
[ Event Log(Application) ]
Source: MR_MONITOR
Event ID: 195
* x is controller ID number.

It can be restrained by this log printout's inputing 'D' with the next message indicated at the time of a server start.

The battery hardware is missing or malfunctioning, or the battery is unplugged. If you continue to boot the system, the battery-backed cache will not function. Please contact technical support for assistance.

Press 'D' to disable this warning (if your controller does not have a battery).
```

- If a redundant power unit is not installed to the NEC Storage ST1220, the following popup message may be shown up while installing MSM. The following event in MSM and in the application event logs may also appear at every boot time. Ignore them.

```
[ MSM Log ]
Controller ID:x BBU disables; changing WB logical drivers to WT.
[ Event Log(Application) ]
Source: MR_MONITOR
Event ID: 173
* x is controller ID number.
```

- When connecting the NEC Storage ST1220 Disk Expansion Unit to the LSI Logic MegaRAID SAS 8480E Disk Array Controller, it is mandatory to check the slot numbers of the drives before you use configuration wizard, rebuild feature or reconstruction feature.

  - The slot numbers are not displayed while executing the features and you need to select the physical drive numbers. Note that the physical drive numbers which are displayed in the left panel of the physical view may be different from the actual slot numbers of the drives. You can see the slot numbers in the Properties view of drives on MSM, as shown on the following screen capture.

  - The slot numbers start from 0, although those printed on the unit start from 1.
To avoid selecting the wrong drives, we highly recommended you check them properly by executing the ‘Locate Physical Drive’ or the ‘Locate Virtual Disk’ operation on MSM.
5.3 Cautions and Restrictions for the LSI Logic Embedded MegaRAID™

MSM Operation

- MSM can not set the "Virtual Disk Properties" for several "Virtual Disks" at the same time. If you want to set the "Virtual Disk Properties" to the second Virtual Disk and all subsequent Disks, select "Rescan" to refresh the display.

- The "Progress display" and "HDD icon" cannot be updated automatically when "Rebuild" is done by RAID10. Please use the "Rescan" feature as a workaround.

- "Dedicated Hotspare" is not supported with MSM on the "LSI Logic Embedded MegaRAID(tm)" environment, even if it is in the menu.

Making & Removing Logical Drives

- When you make a "Virtual Disk" using the "Configuration Wizard", "Disk Cache Policy" is set to the value dependent on "Write Policy".

- MSM can not delete a "Virtual disk" during the "Rebuilding" and "Checking Consistency" operations.

- Do not change "Default Write Policy" with the "Manual Configuration" or with the "Guided Configuration".

Miscellaneous

- MSM logs are shown as GMT. The system event logs are shown correctly by local time. If you use the sort feature of the MSM logs, restart MSM to display the logs chronologically.

- Task Rates is not supported.

- When you change the name of a "Virtual Disk", the MSM display cannot be refreshed. In this case, no message is registered.

- The "Virtual Disk" name is cleared when the server is rebooted.

- When detecting an ECC error using the "Check Consistency " feature, the "Media Error Count" is not refreshed automatically. Please use "Rescan" in this case.

- In the Windows XP 64bit environment, "Windows 2003" is displayed in the "OS name" field in the server selection screen and property display of MSM.
Appendix A  Report Monitoring

Event messages associated with the MegaRAID Storage system can be displayed using NEC ESMPRO Manager. The setting varies depending on the environment as follows:

- To monitor messages with the NEC ESMPRO Manager operating on a system other than the server to which the monitored MegaRAID is connected, you first need to follow the setup procedure below.

- To monitor messages with the NEC ESMPRO Manager operating on the server to which the monitored MegaRAID is connected, no setup is required.

Alert report registry setup procedure

1. Insert the EXPRESSBUILDER CD-ROM into the CD-ROM drive. If the [Master Control] menu appears on the screen, close the menu.
   
   If there is no MSM installer in the "EXPRESSBUILDER" CD, install MSM manually with the CD which is attached to the Controller card.

2. Start "MSMALTEN.EXE" in the "\MSM\" directory of EXPRESSBUILDER.
   
   Using the CD attached to the Controller card, also start "MSMALTEN.EXE" in the "\MSM\"directory.
   
   Confirm when prompted to do so.

3. Once the registry setup is completed, a dialog box appears. Click [OK] to reboot the system.
Alert report messages and actions against the messages

If MSM is installed, the following messages registered as "MSM" are set as report targets. To change the setting, use the NEC ESMPRO Agent report setup procedure.

The event IDs in the table below are decimal numbers.

- A mark "√" in the Manager column indicates the transmission of the report to NEC ESMPRO Manager.
- A Mark "√" in the Alive column indicates the transmission of the report to the express report service. Every report is sent as information.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Message</th>
<th>Action</th>
<th>Manager</th>
<th>ALIVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Unable to recover cache data from TBBU</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>10</td>
<td>Controller cache discarded due to memory/battery problems</td>
<td>Check the memory and battery.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>11</td>
<td>Unable to recover cache data due to configuration mismatch</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Controller cache discarded due to firmware version incompatibility</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Fatal firmware error</td>
<td>A firmware error occurs. Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>17</td>
<td>Flash downloaded image corrupt</td>
<td>The flash image may be damaged. Check the flash image.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Flash error</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>23</td>
<td>Flash programming error</td>
<td>Check the media used for flash. If the media is not defective, replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>24</td>
<td>Flash timeout during programming</td>
<td>Check the media used for flash. If the media is not defective, replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>25</td>
<td>Flash chip type unknown</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>26</td>
<td>Flash command set unknown</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>27</td>
<td>Flash verify failure</td>
<td>Replace the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>32</td>
<td>Multi-bit ECC error</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Single-bit ECC error:</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Not enough controller memory</td>
<td>Plan the replacement of the disk array controller.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>46</td>
<td>Background Initialization aborted on VD</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Background Initialization corrected medium error</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Background Initialization completed with uncorrectable errors on VD</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>50</td>
<td>Background Initialization detected uncorrectable double medium errors</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>51</td>
<td>Background Initialization failed on VD</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>56</td>
<td>Consistency Check aborted on VD</td>
<td>The consistency check is aborted. Check the validity.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>Event ID</td>
<td>Message</td>
<td>Action</td>
<td>Manager</td>
<td>ALIVE</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>57</td>
<td>Consistency Check corrected medium error</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Consistency Check detected uncorrectable double medium errors</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>61</td>
<td>Consistency Check failed on VD</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Consistency Check failed with uncorrectable data on VD</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Consistency Check found inconsistent parity on VD strip</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Consistency Check inconsistency logging disabled, too many inconsistencies on VD</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>67</td>
<td>Initialization aborted on VD</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>68</td>
<td>Initialization failed on VD</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>75</td>
<td>Reconstruction stopped due to unrecoverable errors</td>
<td>If the error recurs, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>76</td>
<td>Reconstruct detected uncorrectable double medium errors</td>
<td>If the error recurs, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>79</td>
<td>Reconstruction resume failed due to configuration mismatch</td>
<td>If the error recurs, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>82</td>
<td>PD Clear aborted</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>83</td>
<td>PD Clear failed</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>87</td>
<td>Error</td>
<td>Contact the support department.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Hot Spare SMART polling failed</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>92</td>
<td>PD is not supported</td>
<td>Check whether a supported physical drive is inserted.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>93</td>
<td>Patrol Read corrected medium error.</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>95</td>
<td>Patrol Read found an uncorrectable medium error</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>96</td>
<td>PD Predictive failure</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>97</td>
<td>Puncturing bad block</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>98</td>
<td>Rebuild aborted by user</td>
<td>The rebuild was aborted by some user operation. Build RAID again.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Rebuild failed due to source drive error</td>
<td>The source physical drive may be damaged. The replacement of the physical drive and the recovery from the backup.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>102</td>
<td>Rebuild failed due to target drive error</td>
<td>The target physical drive may be damaged. Plan the replacement of the physical drive.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>107</td>
<td>Rebuild stopped due to loss of cluster ownership</td>
<td>Check the authority.</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>Reassign write operation failed</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>109</td>
<td>Unrecoverable medium error during rebuild</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Event ID</td>
<td>Message</td>
<td>Action</td>
<td>Manager</td>
<td>ALIVE</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>111</td>
<td>Unrecoverable medium error during recovery</td>
<td>If the error occurs frequently, plan a preventive replacement of physical drives.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>119</td>
<td>SAS topology error: Loop detected</td>
<td>Check the connection of the disk array controller.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>120</td>
<td>SAS topology error: Device not addressable</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>121</td>
<td>SAS topology error: Multiple ports to the same SAS address</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>122</td>
<td>SAS topology error: Expander error</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>123</td>
<td>SAS topology error: SMP timeout</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>124</td>
<td>SAS topology error: Out of route entries</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>125</td>
<td>SAS topology error: Index not found</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>126</td>
<td>SAS topology error: SMP function failed</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>127</td>
<td>SAS topology error: SMP CRC error</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>128</td>
<td>SAS topology error: Multiple subtractive</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>129</td>
<td>SAS topology error: Table to table</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>130</td>
<td>SAS topology error: Multiple paths</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>131</td>
<td>Unable to access device</td>
<td>Check whether the disk array controller is connected correctly.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>134</td>
<td>Dedicated Hot Spare no longer useful for all arrays</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>137</td>
<td>Global Hot Spare does not cover all arrays</td>
<td>Plan a preventive replacement of physical drives.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>140</td>
<td>VD Marked inconsistent due to active writes at shutdown</td>
<td>Check the consistency for confirmation.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>145</td>
<td>Battery temperature is high</td>
<td>The battery temperature is too high. If the error occurs frequently, plan the replacement of the battery.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>146</td>
<td>Battery voltage low</td>
<td>If the error occurs frequently, plan the replacement of the battery.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>148</td>
<td>Battery is discharging</td>
<td>If the error occurs frequently, plan the replacement of the battery.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Battery needs to be replaced, SOH Bad</td>
<td>Replace the battery.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>154</td>
<td>Battery relearn timed out</td>
<td>Replace the battery.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>162</td>
<td>Current capacity of the battery is below threshold</td>
<td>If the error occurs frequently, plan the replacement of the battery.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>166</td>
<td>Communication lost on enclosure</td>
<td>Check the enclosure connection.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>168</td>
<td>Fan failed on enclosure</td>
<td>Check the enclosure fan operation.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>170</td>
<td>Fan removed on enclosure</td>
<td>Check the enclosure fan connection.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>171</td>
<td>Power supply failed on enclosure</td>
<td>Check the enclosure power supply.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>177</td>
<td>Temperature sensor below warning threshold on enclosure</td>
<td>The temperature sensor data exceeds the warning threshold. Check the temperature.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Event ID</td>
<td>Message</td>
<td>Action</td>
<td>Manager</td>
<td>ALIVE</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>178</td>
<td>Temperature sensor below error threshold on enclosure</td>
<td>The temperature sensor data exceeds the error threshold. Check the temperature.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>179</td>
<td>Temperature sensor above warning threshold on enclosure</td>
<td>The temperature sensor data exceeds the warning threshold. Check the temperature.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>Temperature sensor above error threshold on enclosure</td>
<td>The temperature sensor data exceeds the error threshold. Check the temperature.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>181</td>
<td>Enclosure shutdown</td>
<td>Check the enclosure.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>182</td>
<td>Too many enclosures connected to port. Enclosure not supported</td>
<td>Decrease the number of connected enclosures.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>183</td>
<td>Firmware mismatch on enclosure</td>
<td>The compatibility with the firmware of the enclosure is disabled. Contact the support department.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>184</td>
<td>Sensor bad on enclosure</td>
<td>Contact the support department.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>185</td>
<td>Phy is bad on enclosure</td>
<td>The enclosure may be defective. Plan a replacement.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>186</td>
<td>Unstable Enclosure</td>
<td>The enclosure may be defective. Plan a replacement.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>187</td>
<td>Hardware error on enclosure</td>
<td>The enclosure may be defective. Plan a replacement.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>188</td>
<td>No response from enclosure</td>
<td>The enclosure may be defective. Plan a replacement.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>189</td>
<td>SAS/SATA mixing not supported in enclosure; disabled PD</td>
<td>SAS and SATA coexist in a specific enclosure. Check whether the connection is configured correctly.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Unsupported hotplug was detected on SES enclosure</td>
<td>The hot-plug is not supported.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>195</td>
<td>BBU disabled; changing WB logical drives to WT</td>
<td>Check the battery.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>196</td>
<td>Bad block table is 80% full on PD</td>
<td>The bad block table in the physical drive is filled by 80% or larger. Replace the physical drive.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>197</td>
<td>Bad block table is full; unable to log block</td>
<td>The bad block table in the physical drive is full. Replace the physical drive.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>198</td>
<td>Consistency Check Aborted Due to Ownership Loss on V</td>
<td>Check the authority.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>199</td>
<td>Background Initialization (BGI) aborted due to ownership loss on V</td>
<td>Check the authority.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Battery/charger problems detected; SOH Bad</td>
<td>Replace the battery.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>201</td>
<td>Single-bit ECC error; warning threshold exceeded</td>
<td>Plan the replacement of the physical drive.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>202</td>
<td>Single-bit ECC error; critical threshold exceeded</td>
<td>Replace the physical drive.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>203</td>
<td>Single-bit ECC error; further reporting disabled</td>
<td>Replace the physical drive.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>204</td>
<td>Power supply switched off for enclosure</td>
<td>Check the power of the enclosure.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>206</td>
<td>Power supply cable removed on enclosure</td>
<td>Check whether the power cable of the enclosure is disconnected.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>211</td>
<td>BBU Retention test failed!</td>
<td>Replace the BBU.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>214</td>
<td>NVRAM Retention test failed!</td>
<td>Replace the disk array controller.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>216</td>
<td>FAILED Test</td>
<td>The test detects an error. Plan the replacement of the disk array controller.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Event ID</td>
<td>Message</td>
<td>Action</td>
<td>Manager</td>
<td>ALIVE</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>221</td>
<td>NVRAM is corrupt; reinitializing</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk array controller.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>222</td>
<td>NVRAM mismatch occurred</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk array controller.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>223</td>
<td>Link lost on SAS wide port</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk array controller.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>225</td>
<td>Allowed error rate exceeded on SAS port</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk and disk array controller.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>226</td>
<td>Bad block reassigned</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>228</td>
<td>Temperature sensor differential detected on enclosure</td>
<td>If the error occurs frequently, plan the preventive replacement of the enclosure.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>229</td>
<td>Disk test cannot start. No qualifying disks found</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>230</td>
<td>Time duration provided by host is not sufficient for self check</td>
<td>If the error occurs frequently, plan the preventive replacement of the disk array controller.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>235</td>
<td>Firmware download failed on enclosure</td>
<td>If the error occurs frequently, plan the preventive replacement of the enclosure.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>236</td>
<td>Drive is not certified</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>238</td>
<td>PDs missing from configuration at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>239</td>
<td>VDs missing drives and will go offline at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>VDs missing at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>241</td>
<td>Previous configuration completely missing at boot</td>
<td>Check the disk connection.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>245</td>
<td>PD rebuild not possible as SAS/SATA is not supported in an array</td>
<td>Check whether the physical drives to be used are supported.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>VD is now PARTIALLY DEGRADED</td>
<td>Partial degrading is detected. Replace the defective physical drive and run the rebuild operation.</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>251</td>
<td>VD is now DEGRADED</td>
<td>The logical drive is degraded. Replace the defective physical drive and run the rebuild operation.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>252</td>
<td>VD is now OFFLINE</td>
<td>The logical drive enters the offline status. Recover the data by using the backup.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>